RL78/I1A DC/DC LED Control Evaluation Board (EZ-0012)

User’s Manual: Hardware

16-bit Microcontroller

RL78/I1A  R5F107DEG

All information contained in these materials, including products and product specifications, represents information on the product at the time of publication and is subject to change by Renesas Electronics Corp. without notice. Please review the latest information published by Renesas Electronics Corp. through various means, including the Renesas Electronics Corp. website (http://www.renesas.com).
Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for the incorporation of these circuits, software, and information in the design of your equipment. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever for any damages incurred by you resulting from errors in or omissions from the information included herein.

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights of third parties by or arising from the use of Renesas Electronics products or technical information described in this document. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others.

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from such alteration, modification, copy or otherwise misappropriation of Renesas Electronics product.

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The recommended applications for each Renesas Electronics product depends on the product’s quality grade, as indicated below.

   “Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots etc.

   “High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-crime systems; and safety equipment etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may cause serious property damages (nuclear reactor control systems, military equipment etc.). You must check the quality grade of each Renesas Electronics product before using it in a particular application. You may not use any Renesas Electronics product for any application for which it is not intended. Renesas Electronics shall not be in any way liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for which the product is not intended by Renesas Electronics.

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or damages arising out of the use of Renesas Electronics products beyond such specified ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You should not use Renesas Electronics products or technology described in this document for any purpose relating to military applications or use by the military, including but not limited to the development of weapons of mass destruction. When exporting the Renesas Electronics products or technology described in this document, you should comply with the applicable export control laws and regulations and follow the procedures required by such laws and regulations.

10. It is the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or otherwise places the product with a third party, to notify such third party in advance of the contents and conditions set forth in this document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as a result of unauthorized use of Renesas Electronics products.

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.
NOTES FOR CMOS DEVICES

(1) VOLTAGE APPLICATION WAVEFORM AT INPUT PIN: Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between $V_{IL}$ (MAX) and $V_{IH}$ (MIN) due to noise, etc., the device may malfunction. Take care to prevent chattering noise from entering the device when the input level is fixed, and also in the transition period when the input level passes through the area between $V_{IL}$ (MAX) and $V_{IH}$ (MIN).

(2) HANDLING OF UNUSED INPUT PINS: Unconnected CMOS device inputs can be cause of malfunction. If an input pin is unconnected, it is possible that an internal input level may be generated due to noise, etc., causing malfunction. CMOS devices behave differently than Bipolar or NMOS devices. Input levels of CMOS devices must be fixed high or low by using pull-up or pull-down circuitry. Each unused pin should be connected to VDD or GND via a resistor if there is a possibility that it will be an output pin. All handling related to unused pins must be judged separately for each device and according to related specifications governing the device.

(3) PRECAUTION AGAINST ESD: A strong electric field, when exposed to a MOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps must be taken to stop generation of static electricity as much as possible, and quickly dissipate it when it has occurred. Environmental control must be adequate. When it is dry, a humidifier should be used. It is recommended to avoid using insulators that easily build up static electricity. Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and measurement tools including work benches and floors should be grounded. The operator should be grounded using a wrist strap. Semiconductor devices must not be touched with bare hands. Similar precautions need to be taken for PW boards with mounted semiconductor devices.

(4) STATUS BEFORE INITIALIZATION: Power-on does not necessarily define the initial status of a MOS device. Immediately after the power source is turned ON, devices with reset functions have not yet been initialized. Hence, power-on does not guarantee output pin levels, I/O settings or contents of registers. A device is not initialized until the reset signal is received. A reset operation must be executed immediately after power-on for devices with reset functions.

(5) POWER ON/OFF SEQUENCE: In the case of a device that uses different power supplies for the internal operation and external interface, as a rule, switch on the external power supply after switching on the internal power supply. When switching the power supply off, as a rule, switch off the external power supply and then the internal power supply. Use of the reverse power on/off sequences may result in the application of an overvoltage to the internal elements of the device, causing malfunction and degradation of internal elements due to the passage of an abnormal current. The correct power on/off sequence must be judged separately for each device and according to related specifications governing the device.

(6) INPUT OF SIGNAL DURING POWER OFF STATE: Do not input signals or an I/O pull-up power supply while the device is not powered. The current injection that results from input of such a signal or I/O pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal elements. Input of signals during the power off state must be judged separately for each device and according to related specifications governing the device.
Preface

Readers This manual is intended for users who want to understand the functions of the concerned microcontrollers.

Purpose This manual presents the hardware manual for the concerned microcontrollers.

Organization This system specification describes the following sections:

- Introduction
- System configuration
- Board components
- Getting started
- Hardware installation
- Software installation
- How to use Renesas Flash Programmer (RFP)
- Applilet EZ for HCD controller
- Troubleshooting
- Schematics
- Bill of materials

Module instances These microcontrollers may contain several instances of a dedicated module. In general the different instances of such modules are identified by the index “n”, where “n” counts from 0 to the number of instances minus one.

Legend Symbols and notation are used as follows:

- Weight in data notation: Left is high order column, right is low order column
- Active low notation: xxx (pin or signal name is over-scored) or /xxx (slash before signal name) or _xxx
- Memory map address: High order at high stage and low order at low stage

Note Additional remark or tip

Caution Item deserving extra attention

Numeric notation
- Binary: xxxx or xxxB
- Decimal: xxxx
- Hexadecimal: xxxxH or 0x xxxx

Numeric prefixes Representing powers of 2 (address space, memory capacity):
- K (kilo): \(2^{10} = 1024\)
- M (mega): \(2^{20} = 1024^2 = 1,048,576\)
- G (giga): \(2^{30} = 1024^3 = 1,073,741,824\)

Register contents X, x = don’t care

Diagrams Block diagrams do not necessarily show the exact wiring in hardware but the functional structure. Timing diagrams are for functional explanation purposes only, without any relevance to the real hardware implementation.
Safety Precautions

This document describes items to be observed to ensure the safe use of this evaluation board. Be sure to read this document before using the board.

Symbols Used

This document uses the following symbols for items to be observed to ensure the safe use of the unit. The symbols are followed by a brief explanation of the possible extent of problems which may occur if the items are not observed.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>⚠️ Danger</td>
<td>The risk is high if the warning is not observed, and the user may suffer death or serious injury.</td>
</tr>
<tr>
<td>⚠️ Warning</td>
<td>The user may suffer death or serious injury if the warning is not observed.</td>
</tr>
<tr>
<td>⚠️ Caution</td>
<td>Human injury or property damage may occur if the caution is not observed.</td>
</tr>
</tbody>
</table>

The following symbols express behaviors that are prohibited in order to prevent injury or accident.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>❌ General prohibition</td>
<td>The action mentioned is prohibited.</td>
</tr>
<tr>
<td>⚠️ Do not touch</td>
<td>Touching the specified location may cause injury.</td>
</tr>
<tr>
<td>❌ Do not disassemble</td>
<td>Disassembly may cause a problem such as electric shock or product failure.</td>
</tr>
<tr>
<td>❌ Keep away from water</td>
<td>Use near water poses the risk of electric shock or product failure if moisture were to contact the unit.</td>
</tr>
<tr>
<td>⚠️ Flammable</td>
<td>Proximity to flame may cause the unit to catch fire.</td>
</tr>
<tr>
<td>❌ Do not touch with wet hands</td>
<td>Touching with wet hands may cause electric shock or product failure.</td>
</tr>
</tbody>
</table>

The following symbols are used for cautions to prevent product failure and accidents.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>⚠️ General caution</td>
<td>Unspecified general cautions</td>
</tr>
<tr>
<td>⚠️ Caution: Hot</td>
<td>Human injury due to a high temperature</td>
</tr>
</tbody>
</table>

The following symbols are used for instructions to prevent product failure and accidents.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>⚠️ Action required of the user</td>
<td></td>
</tr>
<tr>
<td>⚠️ Instruction to unplug from AC power supply</td>
<td></td>
</tr>
</tbody>
</table>
### Warnings

<table>
<thead>
<tr>
<th>Warning</th>
</tr>
</thead>
</table>
| **Be careful to avoid burns.**  
The temperature of this part of board increases when AC power is connected. |
| **Be careful of LED brightness and the LED On/Off interval.**  
Simulations of strong light may cause symptoms linked to an epileptic condition. |
| **Do not use this board for a purpose other than the evaluation of an MCU.**  
This board does not include the safety measures or anti-EMI measures required for lighting equipment. |
| **Do not heat the board or expose it to fire and do not short the terminals.**  
Doing so may cause the product to fail, heat up, catch fire, or rupture. |
| **Do not disassemble or modify the board.**  
Doing so may cause the product to fail, emit smoke, or catch fire, or result in electric shock. |
| **Do not touch with wet hands.**  
Doing so while connected to power may cause the product to fail or result in electric shock. |
| **Do not look directly at the LEDs on this board.**  
Doing so may weaken eyesight. |
| **Do not drop the board or subject the board to heavy impact.**  
Doing so may break or damage the board, causing fire or electric shock. |
| **Do not turn on the power switch when the AC adapter, interface cable, or other cables are not properly connected.**  
Doing so may cause the product to fail, heat up, or catch fire, or result in electric shock. |
| **Do not plug in or unplug a connector or cable with power applied to the board.**  
Doing so may cause the product to fail, heat up, or catch fire, or result in electric shock. |
| **Do not move this board when the AC adapter or any cables are connected.**  
Doing so may damage cables and cause the product to fail, heat up, or catch fire, or result in electric shock. |
| **Use this board with a spacer and on an electrically isolated bench.**  
If a conductor contacts the board, the product may fail, heat up, or catch fire, or it may result in electric shock. |
| **Use an AC adapter adapted to the safety standard of each country.**  
Using an inappropriate AC adapter may cause the product to fail, heat up, or catch fire, or result in electric shock. |
| **Use the specified AC adapter.**  
Using an AC adapter other than that specified may cause the product to fail, heat up, or catch fire, or result in electric shock. |
| **Use an AC adapter of the following size and DC plug polarity.**  
EIAJ Type2 Plug (outer diameter: 4.0 mm, inner diameter: 1.7 mm)  
Using another type of AC adapter may cause the product to fail, heat up, or catch fire, or result in electric shock. |
| **Confirm that the outlet is near this board and can be easily unplugged.** |
If smoke or an abnormal smell or sound is emitted or if overheating occurs, promptly switch off the board power and unplug the AC power supply. Using the board in such a state poses a risk of fire, burning or electric shock.

Cautions

Do not use or store this board in any of the following locations.
- Environments with excessive water, humidity, steam, dust, fume, etc.
- Environments where static electricity or electrical noise is readily generated.
  Such influences can lead to electric shock or product failure.
If liquid enters the board, disconnect the power supply, and consult your dealer or Renesas Electronics sales representative.
  Even if the unit appears to be dry, internal moisture may remain.

Do not directly touch LEDs on this board.
  Doing so may cause product failure.

To prevent static electricity damage, guard against static discharge when touching metal parts such as the connector.
  Static electricity can cause product failure.
Overview
This board is used to evaluate LED control by the RL78/I1A microcontroller.

This board can operate with the 5 VDC power supply provided by an AC adapter, which should be prepared separately.

By using the Lighting Communication Master Evaluation Board (EZ-0008) and a GUI tool (which can be downloaded from the Renesas Electronics’ website), dimming evaluation by DALI, DMX512 or infrared data communication protocol is possible.

*Prepare an AC adapter that satisfies the following:
- Output voltage: 5 VDC
- Output current: > 2 A
- Type: Switching regulator type with overcurrent protection circuit
  Do not use an AC adapter whose output voltage is guaranteed only when the rated load current flows.
- Connector plug: EIAJ–2 (outer diameter: 4.0 mm, inner diameter: 1.7 mm)

⚠️ Warning
Use an AC adapter that conforms to the safety standard of each country.
Using an incorrect AC adapter causes the product to fail, heat up, or catch fire, or result in electric shock.
Appearance of the board

Surface appearance (top view)

- Analog volume switch
- DC plug for AC adaptor
- Connector for DALI
- Connector for DMX512
- USB connector

Surface appearance (back view)

- High brightness LED

---

**Warning**

- **Be careful to avoid burns.**
  Parts of the board, especially the area enclosed by a dotted line, become extremely hot.

- **Do not look directly at LEDs on this board.**
  Doing so may weaken eyesight.
  Use this board with the LED mounting surface back.

- **Use a specified AC adapter.**
  Using an AC adapter other than that specified causes the product to fail, heat up, or catch fire, or electric shock.
Do not touch directly LEDs on this board. Doing so may cause a product failure.

For usage of this board, see the User’s Manual. The User’s Manual can be downloaded from the following webpage.
URL: http://tool-support.renesas.com/eng/toolnews/download/exel/solution_lighting.html
Table of Contents

Chapter 1  Introduction ................................................................................................. 1
  1.1 Main features of RL78/I1A DC/DC LED Control Evaluation Board ................. 1
  1.2 System requirements ......................................................................................... 2
  1.3 Package contents .............................................................................................. 2

Chapter 2  System Configuration ............................................................................... 3
  2.1 RL78/I1A DC/DC LED Control Evaluation Board ........................................... 3
  2.2 Host Computer .................................................................................................. 3
  2.3 Power Supply ................................................................................................... 3

Chapter 3  Board Components .................................................................................. 4
  3.1 Configuration Switch SW2 .................................................................................. 4
      3.1.1 Normal Operation Mode ............................................................................... 4
      3.1.2 On-Board Debug (OCD) Mode / Flash Programming Mode ....................... 5
      3.1.3 E1 On-Chip Debug Mode ............................................................................. 5
      3.1.4 Virtual UART Mode .................................................................................... 6
  3.2 Configuration Switch SW1 .................................................................................... 6
  3.3 Configuration Switch SW3 ................................................................................... 7
  3.4 Reset Switch SW501 ........................................................................................... 7
  3.5 External Power Supply CN1 ............................................................................... 7
  3.6 DALI Interface Connector CN2 .......................................................................... 7
  3.7 DMX512 Interface Connector CN3 .................................................................... 7
  3.8 InfraRed Detector U2 ........................................................................................ 7
  3.9 E1 Emulator Connector J4 ................................................................................ 8
  3.10 Programming Connector J3 ............................................................................... 8
  3.11 Mini-B USB Interface Connector CN501 .......................................................... 8
  3.12 External Connectors J1 and J2 ......................................................................... 9
  3.13 Low Power 32 KHz Resonator Y1 .................................................................. 11
  3.14 RL78/I1A Memory Map .................................................................................. 11

Chapter 4  Getting Started ......................................................................................... 12

Chapter 5  Hardware Installation .............................................................................. 13

Chapter 6  Software Installation ............................................................................... 14
  6.1 CubeSuite+ IDE Installation ............................................................................. 14
  6.2 Applilet EZ for HCD Controller Installation .................................................... 14
  6.3 USB Driver Installation .................................................................................... 15
      6.3.1 Installation on Windows XP ......................................................................... 15
      6.3.2 Installation on Windows Vista ................................................................. 18
      6.3.3 Installation on Windows 7 ........................................................................... 20
6.3.4 Confirmation of USB Driver Installation

Chapter 7 How to Use Renesas Flash Programmer (RFP)

Chapter 8 Applilet EZ for HCD Controller
  8.1 General Settings
  8.2 Fix Dimmer Program
  8.3 Variable Dimmer Program
  8.4 Analog Input Dimmer Program
  8.5 DMX512 Dimmer Program
  8.6 DALI Dimmer Program
  8.7 IR Remote Control Dimmer Program

Chapter 9 Troubleshooting

Chapter 10 Schematics

Chapter 11 Bill of Materials
Chapter 1 Introduction

The RL78/I1A DC/DC LED Control Evaluation Board is an evaluation board that integrates the Renesas RL78/I1A microcontroller. It supports On-Board debugging and flash programming, and is intended to demonstrate the RL78/I1A MCU's LED lighting system control.

1.1 Main features of RL78/I1A DC/DC LED Control Evaluation Board

- LED lighting system control demonstration capabilities
  - The RL78/I1A DC/DC LED Control Evaluation Board demonstrates constant current control of LEDs by using 16-bit timers KBn (n = 0, 1, 2) dedicated to PWM output.
    - Buck topology
    - Constant current drive of 350 mA (max.) × 3 channels
- 4 types of dimming control interface supported
  - 3 ch. analog volume control interface (for standalone evaluation)
  - DALI protocol communication interface
  - DMX512 protocol communication interface
  - IR remote control interface
- Easy to use device demonstration capabilities
  - The RL78/I1A DC/DC LED Control Evaluation Board contains elements to easily demonstrate I/O-functions (i.e. LED output, I/O lines, UART serial interface) together with Real Time Clock (RTC), ADC and Timers.
- Power supply via 5V DC connector
  - The RL78/I1A DC/DC LED Control Evaluation Board is powered via a 5V DC jack connector. This power supply is used to power the RL78/I1A as well as the LEDs. When On-Board debug function is used, the USB interface is used to power the µPD78F7030 78K0 USB microcontroller.
- On-Board debug function
  - The RL78/I1A DC/DC LED Control Evaluation Board supports an On-Board debug function by using the CubeSuite+ IDE, without the need of additional debug hardware. It allows flash programming and supports standard debug functions such as code execution, step execution, software breakpoints, memory manipulation etc. (The E1 emulator can also be used for on-chip debugging.)
- Renesas Flash Programmer (RFP)
  - Windows based Flash programming software allows the user to select and download application programs to the RL78/I1A DC/DC LED Control Evaluation Board for evaluation purposes via USB.
- Appillet EZ for HCD Controller, Automated software generation tool
  - Software tool used to generate full projects for different compilers.
- Various I/O signals available, such as
  - All I/O ports prepared to be connected
  - Virtual UART interface, via the µPD78F0730 78K0 8-bit microcontroller with on-board USB interface
• The CubeSuite+ Integrated Development Environment (IDE) supports the RL78/I1A devices. This package is not restricted in program code size.

• Full documentation is included for the Renesas Electronics software tools and the RL78/I1A device.

1.2 System requirements

HOST PC

A PC supporting Windows XP, Windows Vista or 7 is required for the development tools installation. A Pentium processor with at least 1 GHz CPU performance, with at least 256 Mbytes of RAM, allowing you to fully utilize and take advantage of the product features.

350 Mbytes of free disk space and an additional 10 Mbytes of free disk space on the Windows system drive.

A web browser and Adobe Acrobat Reader to be able to access all the product documentation.

Host interface

USB interface that enables communication based on USB (Ver1.1 or later)

1.3 Package contents

• RL78/I1A DC/DC LED Control Evaluation Board
• USB Type A / Mini-B cable
• Connection wires for DMX512 and DALI connectors

If any part is missing or seems to be damaged, please contact the dealer from whom you received your RL78/I1A DC/DC LED Control Evaluation Board.
Chapter 2 System Configuration

The RL78/I1A DC/DC LED Control Evaluation Board system configuration is given in the diagram below:

![Diagram of RL78/I1A DC/DC LED Control Evaluation Board System Configuration](image)

Figure 1: RL78/I1A DC/DC LED Control Evaluation Board System Configuration

### 2.1 RL78/I1A DC/DC LED Control Evaluation Board

RL78/I1A DC/DC LED Control Evaluation Board is a demonstration board for evaluating the Renesas RL78/I1A family of devices. The device used is the RL78/I1A (R5F107DEG). The board can be directly connected to the host system via a USB port. The host system may be used for On-Board debugging or Flash programming and to allow execution of the Demonstration program on the RL78/I1A device.

As default, the RL78/I1A is using the 32 MHz internal high-speed oscillator, but the RL78/I1A DC/DC LED Control Evaluation Board is also provided with a connection for an external 20 MHz oscillator (not fitted) if the user wishes to use an external clock. An external low power 32.768 KHz resonator can be used for the sub-clock.

### 2.2 Host Computer

The USB host interface enables communication to the RL78/I1A DC/DC LED Control Evaluation Board. The μPD78F0730 78K0 8-bit microcontroller with on-chip USB interface and the Renesas Electronics virtual UART driver allows application software to access the USB device in the same way as it would access a standard RS232 interface. The Renesas Electronics virtual UART driver appears to the windows system as an extra Com Port, in addition to any existing hardware Com Ports.

### 2.3 Power Supply

RL78/I1A DC/DC LED Control Evaluation Board is powered by a 5V DC power supply and also via USB interface during On-Board debugging, flash programming or virtual UART communication.
Chapter 3 Board Components

The RL78/I1A DC/DC LED Control Evaluation Board is equipped with a USB connector and with several connectors in order to be connected to host computers, E1 emulator, DALI or DMX master or any external target hardware.

Some of the RL78/I1A DC/DC LED Control Evaluation Board components are free for user application hardware and software. Please read the User’s Manual of the RL78/I1A device carefully to get information about the electrical specification of the available I/O ports before you connect any external signal to the RL78/I1A DC/DC LED Control Evaluation Board.

3.1 Configuration Switch SW2

The switch SW2 controls the different operating modes of the RL78/I1A DC/DC LED Control Evaluation Board.

3.1.1 Normal Operation Mode

The default operation of the board is set for Normal Operation mode. Switch SW2 should be set as shown in the table below:

<table>
<thead>
<tr>
<th>Bits</th>
<th>Configuration</th>
<th>Schematic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1*</td>
<td>OFF</td>
<td><img src="image" alt="Schematic" /></td>
</tr>
<tr>
<td>2*</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>ON</td>
<td></td>
</tr>
</tbody>
</table>

* When DALI or DMX512 communication is to be used, bits 1 and 2 of switch SW2 should both be set to ON position.
3.1.2 On-Board Debug (OCD) Mode / Flash Programming Mode

The RL78/I1A DC/DC LED Control Evaluation Board supports on-board debug mode via the USB interface achieved by a dedicated monitor running on the RL78/I1A device. By using the CubeSuite+ debugger, flash programming and standard debug functions i.e. code execution, step execution, software breakpoints, memory manipulation etc. are supported.

Additionally the built-in Flash memory of the RL78/I1A device can be re-programmed by using the RFP. Configure switch SW2 as following to use the on-board debug or Flash programming mode:

<table>
<thead>
<tr>
<th>Bits</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>1*</td>
<td>OFF</td>
</tr>
<tr>
<td>2*</td>
<td>OFF</td>
</tr>
<tr>
<td>3</td>
<td>ON</td>
</tr>
<tr>
<td>4</td>
<td>OFF</td>
</tr>
<tr>
<td>5</td>
<td>ON</td>
</tr>
<tr>
<td>6</td>
<td>OFF</td>
</tr>
<tr>
<td>7</td>
<td>ON</td>
</tr>
<tr>
<td>8</td>
<td>OFF</td>
</tr>
</tbody>
</table>

Configure switch SW2 as following to use the on-board debug or Flash programming mode:

Table 2: SW2, On-Board Debug / Flash Programming Mode

* When DALI or DMX512 communication is to be used, bits 1 and 2 of switch SW2 should both be set to ON position.

3.1.3 E1 On-Chip Debug Mode

The RL78/I1A DC/DC LED Control Evaluation Board also supports on-chip debug mode via the E1 emulator. When using the E1 emulator for on-chip debugging, the board can either be powered from the emulator or from the 5V DC power supply.

<table>
<thead>
<tr>
<th>Bits</th>
<th>Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>1*</td>
<td>OFF</td>
</tr>
<tr>
<td>2*</td>
<td>OFF</td>
</tr>
<tr>
<td>3</td>
<td>OFF</td>
</tr>
<tr>
<td>4</td>
<td>OFF</td>
</tr>
<tr>
<td>5</td>
<td>OFF</td>
</tr>
<tr>
<td>6</td>
<td>OFF</td>
</tr>
<tr>
<td>7</td>
<td>ON</td>
</tr>
<tr>
<td>8</td>
<td>ON</td>
</tr>
</tbody>
</table>

Table 3: SW2, E1 On-Chip Debug Mode

* When DALI or DMX512 communication is to be used, bits 1 and 2 of switch SW2 should both be set to ON position.
3.1.4 Virtual UART Mode

The RL78/I1A DC/DC LED Control Evaluation Board supports Virtual UART mode via the µPD78F0730 78K0 8-bit microcontroller. Switch SW2 should be set as shown in the table below:

<table>
<thead>
<tr>
<th>Bits</th>
<th>Configuration</th>
<th>Schematic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1*</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>2*</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>ON</td>
<td></td>
</tr>
</tbody>
</table>

* When DALI or DMX512 communication is to be used, bits 1 and 2 of switch SW2 should both be set to ON position.

3.2 Configuration Switch SW1

The switch SW1 selects the lighting communication protocol to be used by the RL78/I1A DC/DC LED Control Evaluation Board. When using DALI or DMX512 communication, please don’t forget to set bits 1 and 2 of switch SW2 to ON position.

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Function</th>
<th>Schematic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-2 &amp; 4-5</td>
<td>DALI</td>
<td></td>
</tr>
<tr>
<td>3-2 &amp; 6-5</td>
<td>DMX512</td>
<td></td>
</tr>
</tbody>
</table>

Table 4: SW2, Virtual UART Mode

Table 5: SW1, Lighting Communication Protocol Selection
3.3 Configuration Switch SW3

The switch SW3 selects the IR remote control channel. Two different channels can be selected on the **RL78/I1A DC/DC LED Control Evaluation Board**, CH1 corresponds to a 0x5AA5 data code, and CH2 to a 0xDA25 data code.

**Note**
This function is supported by Applilet EZ for HCD Ver. 7.00 or later. The switching function does not operate for versions earlier than 7.00. To switch a data code in an Applilet EZ for HCD version earlier than 7.00, rewrite the data code.

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Function</th>
<th>Schematic</th>
</tr>
</thead>
<tbody>
<tr>
<td>CH1</td>
<td>Custom code: 0x0000+Data code: 0x5AA5</td>
<td>![Schematic CH1]</td>
</tr>
<tr>
<td>CH2</td>
<td>Custom code: 0x0000+Data code: 0xDA25</td>
<td>![Schematic CH2]</td>
</tr>
</tbody>
</table>

Table 6: SW3, IR Remote Control Channel Selection

3.4 Reset Switch SW501

The switch SW501 is the reset switch of the **RL78/I1A DC/DC LED Control Evaluation Board**. It can be used to reset operation during on-board debugging or during normal operation mode.

3.5 External Power Supply CN1

External power is supplied by connecting a regulated 5V DC to the jack connector CN1.

The operation of the board is as follows:
- External supply only (The board can only be operated as stand alone only, no USB power connection).
- Or
  - External supply and USB power (This configuration should be used when the user intends to use On-Board debugging, flash programming or virtual UART communication via the µPD78F0730 78K0 8-bit microcontroller).

3.6 DALI Interface Connector CN2

CN2 is the connector for DALI interface. CN2 is a 2-way connector to enable communication with a DALI master via the DALI communication protocol.

3.7 DMX512 Interface Connector CN3

CN3 is the connector for DMX512 interface. CN3 is a 3-way connector to enable communication with a DMX512 master via the DMX512 communication protocol.

3.8 InfraRed Detector U2

InfraRed (IR) detector U2 can be used to enable IR communication between a controller device and the RL78/I1A. The controller device can send commands to the RL78/I1A microcontroller using the IR communication protocol.
3.9 E1 Emulator Connector J4

Connector J4 (not fitted) is provided to allow debugging and programming of the RL78/I1A microcontroller using the E1 OCD emulator. This function allows the user to be able to debug an application and make use of the UART0 serial interface that can use the Renesas Virtual UART to interface to the PC. For this function a 14-way (2 x 7) standard pitch connector needs to be mounted and connected as shown below.

![E1 Emulator Connection Diagram]

Figure 3: E1 Emulator Connection

3.10 Programming Connector J3

Connector J3 is provided for production programming of the µPD78F0730 78K0 8-bit microcontroller during manufacturing. The 78K0/USB device should not be reprogrammed.

3.11 Mini-B USB Interface Connector CN501

The mini-B USB connector allows connecting the CubeSuite+ IDE or the RFP to the RL78/I1A DC/DC LED Control Evaluation Board in order to debug or program application software to the RL78/I1A device. The power supply for the 78K0/USB device is also provided by this connector.

Additionally connector CN501 connects the UART0 serial interface of the RL78/I1A device to the host system.

![Connector CN501, Mini USB B Type Connector Pin Configuration]

Figure 4: Connector CN501, Mini USB B Type Connector Pin Configuration
Table 7: Pin Configuration of mini-B USB Connector CN501

For connection with the host machine, the *RL78/I1A DC/DC LED Control Evaluation Board* can be plugged directly into an available USB port.

### 3.12 External Connectors J1 and J2

J1 to J2 are connectors for external user hardware. Standard 0.1” pitch, 10-way double row, straight headers are mounted to bring all I/Os for usage. Please read the User’s Manual of the RL78/I1A device carefully to get information about the electrical specification of the available I/O ports.
### Connector J1

<table>
<thead>
<tr>
<th>Signal Name</th>
<th>RL78/I1A Pin Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>P20</td>
<td>P20/ANI0/AVREFP Connected to VDD</td>
</tr>
<tr>
<td>2</td>
<td>P03</td>
<td>P03/RXD1/CMP5P/ANI16</td>
</tr>
<tr>
<td>3</td>
<td>P02</td>
<td>P02/TXD1/ANI17</td>
</tr>
<tr>
<td>4</td>
<td>P120</td>
<td>P120/ANI19</td>
</tr>
<tr>
<td>5</td>
<td>P40</td>
<td>P40/TOOL0</td>
</tr>
<tr>
<td>6</td>
<td>RESET</td>
<td>RESET</td>
</tr>
<tr>
<td>7</td>
<td>P124</td>
<td>P124/XT2/EXCLKS</td>
</tr>
<tr>
<td>8</td>
<td>P123</td>
<td>P123/XT1</td>
</tr>
<tr>
<td>9</td>
<td>P137</td>
<td>P137/INTP0</td>
</tr>
<tr>
<td>10</td>
<td>P122</td>
<td>P122/X2/EXCLK</td>
</tr>
<tr>
<td>11</td>
<td>P121</td>
<td>P121/X1</td>
</tr>
<tr>
<td>12</td>
<td>REGC</td>
<td>REGC</td>
</tr>
<tr>
<td>13</td>
<td>VSS</td>
<td>VSS</td>
</tr>
<tr>
<td>14</td>
<td>VDD</td>
<td>VDD</td>
</tr>
<tr>
<td>15</td>
<td>P31</td>
<td>P31/Ti03/TO03/INTP4</td>
</tr>
<tr>
<td>16</td>
<td>P77</td>
<td>P77/INTP11</td>
</tr>
<tr>
<td>17</td>
<td>P76</td>
<td>P76/INTP10</td>
</tr>
<tr>
<td>18</td>
<td>P61</td>
<td>P61/SDAA0</td>
</tr>
<tr>
<td>19</td>
<td>P75</td>
<td>P75/INTP9</td>
</tr>
<tr>
<td>20</td>
<td>-</td>
<td>- No connection</td>
</tr>
</tbody>
</table>

Table 8: Connector J1

### Connector J2

<table>
<thead>
<tr>
<th>Signal Name</th>
<th>RL78/G13 Pin Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>P21</td>
<td>P21/ANI1/AVREFM Connected to VSS</td>
</tr>
<tr>
<td>2</td>
<td>P22</td>
<td>P22/ANI2/CMP0P</td>
</tr>
<tr>
<td>3</td>
<td>P24</td>
<td>P24/ANI4/CMP1P</td>
</tr>
<tr>
<td>4</td>
<td>P25</td>
<td>P25/ANI5/CMP2P</td>
</tr>
<tr>
<td>5</td>
<td>P26</td>
<td>P26/ANI6/CMP3P</td>
</tr>
<tr>
<td>6</td>
<td>P27</td>
<td>P27/ANI7/CMP4P</td>
</tr>
<tr>
<td>7</td>
<td>P147</td>
<td>P147/CMPCOM/ANI18</td>
</tr>
<tr>
<td>8</td>
<td>P10</td>
<td>P10/S000/TXD0/TKCO00/INTP20/SCLA0/(DALITxD4)</td>
</tr>
<tr>
<td>9</td>
<td>P11</td>
<td>P11/S1000/RXD0/TKCO01/INTP21/SDAA0/(TI07)/(DALIRxD4)/(TxRx4)</td>
</tr>
<tr>
<td>10</td>
<td>P12</td>
<td>P12/_SCK00/(TKCO03)</td>
</tr>
<tr>
<td>11</td>
<td>P200</td>
<td>P200/TKB000/INTP22</td>
</tr>
<tr>
<td>12</td>
<td>P201</td>
<td>P201/TKB001</td>
</tr>
<tr>
<td>13</td>
<td>P202</td>
<td>P202/TKB010/(INTP21)</td>
</tr>
<tr>
<td>14</td>
<td>P203</td>
<td>P203/TKB011/TKCO02/(INTP20)</td>
</tr>
<tr>
<td>15</td>
<td>P204</td>
<td>P204/TKB020/TKCO03</td>
</tr>
<tr>
<td>16</td>
<td>P205</td>
<td>P205/TKB021/TKCO04/DALITxD4</td>
</tr>
<tr>
<td>17</td>
<td>P206</td>
<td>P206/TKCO05/DALIRxD4/TXRx4/INTP23</td>
</tr>
<tr>
<td>18</td>
<td>P30</td>
<td>P30/INTP3/RTC1HZ</td>
</tr>
<tr>
<td>19</td>
<td>P05</td>
<td>P05/TI05/TO05</td>
</tr>
<tr>
<td>20</td>
<td>-</td>
<td>- No connection</td>
</tr>
</tbody>
</table>

Table 9: Connector J2
3.13 Low Power 32 KHz Resonator Y1

The *RL78/I1A DC/DC LED Control Evaluation Board* is fitted with an external 32 KHz resonator (Y1) characterized specifically for the RL78 devices supplied by Seiko Instruments Inc.

This is a specially designed low power resonator designed to support the very low power consumption of the RL78 family.

3.14 RL78/I1A Memory Map

The RL78/I1A memory map is shown in the table below.

<table>
<thead>
<tr>
<th>Address area</th>
<th>Description</th>
<th>Free for user application software</th>
</tr>
</thead>
<tbody>
<tr>
<td>0xFFFFF</td>
<td>SFR Area</td>
<td></td>
</tr>
<tr>
<td>0xFFF00</td>
<td>256 bytes</td>
<td></td>
</tr>
<tr>
<td>0xFFFFF</td>
<td>Internal RAM</td>
<td></td>
</tr>
<tr>
<td>0xFFF00</td>
<td>4KB</td>
<td></td>
</tr>
<tr>
<td>0xFFFFF</td>
<td>Mirror</td>
<td></td>
</tr>
<tr>
<td>0xF2000</td>
<td>51.75 KB</td>
<td></td>
</tr>
<tr>
<td>0xF1FFF</td>
<td>Data flash memory</td>
<td></td>
</tr>
<tr>
<td>0xF1000</td>
<td>4 KB</td>
<td></td>
</tr>
<tr>
<td>0x0F0FFF</td>
<td>Access prohibited area</td>
<td></td>
</tr>
<tr>
<td>0x0F0800</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0x0F07FF</td>
<td>2nd SFR</td>
<td>Free for user application software</td>
</tr>
<tr>
<td>0xF0000</td>
<td>2 KB</td>
<td></td>
</tr>
<tr>
<td>0xEFFFFF</td>
<td>Access prohibited area</td>
<td></td>
</tr>
<tr>
<td>0x10000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0x0FFFFF</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0x00000</td>
<td>64 KB code flash memory</td>
<td>Free for user application software</td>
</tr>
</tbody>
</table>

Table 10: RL78/I1A Memory Map
Chapter 4  Getting Started

The default setting of the RL78/I1A DC/DC LED Control Evaluation Board is set for demonstration of LED constant current control and dimming control using on-board variable resistors. The RL78/I1A DC/DC LED Control Evaluation Board comes already flash programmed with the LED control sample program. Chapter 6 will take the user through the software installation procedure.

Initially the user will be required to install the drivers, all of the development tools and the associated documentation that can be found on the Renesas Electronics website.

Please note as the communication interface between the host computer and the RL78/I1A DC/DC LED Control Evaluation Board is the USB port interface, the hardware and software must be installed properly.
Chapter 5  Hardware Installation

After unpacking the *RL78/I1A DC/DC LED Control Evaluation Board*, connect the supplied USB cable to the board. The connection of the board to the Host PC should be done in conjunction with 6.3 **USB Driver Installation**. This driver must be installed before the user can use the debugger.
Chapter 6  Software Installation

The RL78/I1A DC/DC LED Control Evaluation Board works with several software demonstration packages:

- CubeSuite+ Integrated Development Environment, it provides an environment for developing microcontrollers from creation of pin lists to code generation, build and debug all in one tool
- RFP to allow Flash programming of the RL78/I1A internal Flash memory
- Applilet EZ for HCD Controller to generate full CubeSuite+ projects (for LED constant current and different dimming control interfaces)

The CubeSuite+ IDE, the RFP and the Applilet EZ for HCD Controller software tool must be installed on your PC. For detailed installation hints, refer to the following sections and to the corresponding documentation of the CubeSuite+ IDE and RFP.

6.1 CubeSuite+ IDE Installation

This program can be downloaded from the Renesas Electronics website and installed on the host PC.
http://tool-support.renesas.com/eng/toolnews/download/exel/solution_lighting.html

6.2 Applilet EZ for HCD Controller Installation

This program can be downloaded from the Renesas Electronics website and installed on the host PC.
http://tool-support.renesas.com/eng/toolnews/download/exel/solution_lighting.html
6.3 USB Driver Installation

In order to use the RL78/I1A DC/DC LED Control Evaluation Board in combination with CubeSuite+ IDE or the RFP, “Renesas Electronics Starter Kit Virtual UART” USB driver must be installed on the host machine.

Please follow according to version of Windows OS. Check your Windows version, and follow the instructions:

Installation on Windows XP → 6.3.1
Installation on Windows Vista → 6.3.2
Installation on Windows 7 → 6.3.3

Note Please download the USB driver from the Renesas Electronics website and proceed with the installation using the following guidelines.
http://tool-support.renesas.com/eng/toolnews/download/exel/solution_lighting.html

After the installation, go to 6.3.4 Confirmation of USB Driver Installation.

6.3.1 Installation on Windows XP

When the RL78/I1A DC/DC LED Control Evaluation Board is connected to the host machine, the board is recognized by “Plug and Play”, and the wizard for finding new hardware is started.

Select “No, not this time” and click [Next >].

Figure 6: Found New Hardware Wizard (Windows XP)
Select “Install from a list or a specific location (Advanced)” and click Next >.

![Image of the Found New Hardware Wizard](image1)

**Figure 7:** Install from a Specific Location (Windows XP)

Mark “Include this location in the search” and then browse the computer to select the directory where the USB driver has been copied.

Click Next >.

![Image of the Found New Hardware Wizard](image2)

**Figure 8:** Search Location Specification (Windows XP)
Click **Continue Anyway** to continue the installation.

![Hardware Installation](image)

Figure 9: Installation Confirmation (Windows XP)

Click **Finish** to close the installation wizard.

![Found New Hardware Wizard](image)

Figure 10: USB Driver Installation Completion (Windows XP)
6.3.2 Installation on Windows Vista

When the RL78/I1A DC/DC LED Control Evaluation Board is connected to the host machine for the first time, the board is recognized by “Plug and Play” and the “Found New Hardware” window will pop up.

Select “Locate and install driver software (recommended)”.

![Found New Hardware Wizard (Windows Vista)](image1)

Figure 11: Found New Hardware Wizard (Windows Vista)

Then select “Browse my computer for driver software (advanced)” on the next window.

![Install from a Specific Location (Windows Vista)](image2)

Figure 12: Install from a Specific Location (Windows Vista)
Select the folder where the USB driver has been copied on the host computer. Please be careful, there are different USB drivers available for 32-bit Operating Systems and 64-bit Operating Systems. Click Next >.

Figure 13: Search Location Specification (Windows Vista)

Click Install when the driver has been found.

Figure 14: Installation Confirmation (Windows Vista)
Click Close to close the installation wizard.

6.3.3 Installation on Windows 7

When the RL78/I1A DC/DC LED Control Evaluation Board is connected to the host machine, the board is recognized as an “Unknown Device” in the Device Manager. Right click on the “Unknown Device” and select “Update Driver Software…” within the Device Manager window.

Select “Browse my computer for driver software”.

Figure 15: USB Driver Installation Completion (Windows Vista)

Figure 16: Update Driver Software (Windows 7)
Select the folder where the USB driver has been copied on the host computer. Please be careful, there are different USB drivers available for 32-bit Operating Systems and 64-bit Operating Systems.

Click Next >.

Figure 17: Search Location Specification (Windows 7)

Click Install when the driver has been found.

Figure 18: Installation Confirmation (Windows 7)
Click [Close] to close the installation wizard.

![USB Driver Installation Completion (Windows 7)](image)

Figure 19: USB Driver Installation Completion (Windows 7)
6.3.4 Confirmation of USB Driver Installation

After installing the USB driver, check that the driver has been installed correctly, according to the procedure below.

Open "Device Manager" by entering:

[Start] → [Settings] → [Control Panel] → [System] → tab [Hardware]

When the **RL78/I1A DC/DC LED Control Evaluation Board** is connected to the host PC, the "Renesas Electronics Starter Kit Virtual UART" (without "?” mark) should be present under the section "Ports (COM & LPT)".

The screen above shows that the COM port number is "COM23".

When you change the USB port connection, the COM port number will be changed as well.

![Device Manager](image)

**Figure 20:** Device Manager

**Caution** Do not do “Hardware Modification Scan” when you communicate with the target device.
Chapter 7 How to Use Renesas Flash Programmer (RFP)

This chapter explains the basic operations of the RFP for programming the RL78/I1A DC/DC LED Control Evaluation Board. This chapter covers how to start the system, execute the EPV command (Erase, Program, Verify), and program the target RL78/I1A device.

The conditions of the series of operations described in this chapter are as follows:

<table>
<thead>
<tr>
<th>Hardware Configuration of RL78/I1A DC/DC LED Control Evaluation Board</th>
</tr>
</thead>
<tbody>
<tr>
<td>Board: RL78/I1A DC/DC LED Control Evaluation Board</td>
</tr>
<tr>
<td>CPU: RL78/I1A</td>
</tr>
<tr>
<td>Target Device: R5F107DE</td>
</tr>
<tr>
<td>Voltage level: 5 V</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Software Configuration of RFP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter file: R5F107DE.pr5</td>
</tr>
<tr>
<td>Clock setting: Internal-OSC</td>
</tr>
<tr>
<td>Port: COMxx (115200bps)</td>
</tr>
<tr>
<td>Operation mode: Chip</td>
</tr>
<tr>
<td>Write HEX file: *.hex</td>
</tr>
<tr>
<td>Option Setting: Blank check before Erase</td>
</tr>
</tbody>
</table>

<1> Installing the driver
Install the USB driver on the host machine you are using, by referring to Chapter 6 Software Installation (if the driver has not been installed yet).

<2> Setting and connecting
Set the RL78/I1A DC/DC LED Control Evaluation Board by configuring switch SW2 as following:

<table>
<thead>
<tr>
<th>Bits</th>
<th>Configuration</th>
<th>Schematic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>OFF</td>
<td></td>
</tr>
</tbody>
</table>

Table 11: SW2, Configuration for Flash Programming Mode
Connect the RL78/I1A DC/DC LED Control Evaluation Board with the host machine.

<3> Starting Start the RFP from the start menu:
[Start] → [All Programs] → [Renesas Electronics CubeSuite+] → [Programming Tools]
On the RFP startup screen, select the “Create new workspace” option button and then click [Next] to open the “Create new workspace” dialog box. Select the target microcontroller to use, enter the name in the “Workspace Name” text box, and then click [Next].

![Create new workspace Dialog Box](image)

Select the tool and interface (communication port) to use from the dropdown list, and then click [Next].

![Selection of Communication Interface](image)
The “Power Supply” dialog box is displayed. Enter the power supply voltage in the Input Voltage text box, and then click [Next].

![Power Supply](image)

Figure 25: Power Supply Voltage Setting

The “Project Settings” dialog box is displayed.
Check the settings in the dialog box.
If all settings are correct, click [Complete]. If you want to modify some settings, click [Modify].

![Project Settings](image)

Figure 26: Project Settings Dialog Box

Select the program file to be written to the target microcontroller in the “User/Data area” box.
Next, click [Start] to start writing of the selected program file.
When “PASS” is displayed, close the window.
<9> Terminating  Select [File] \rightarrow [Quit] to terminate the RFP. All settings executed are saved, so that those settings can be reused when the RFP is restarted.

<10> Execute application  Set the RL78/I1A DC/DC LED Control Evaluation Board to the normal operation mode by applying the following settings.

<table>
<thead>
<tr>
<th>Bits</th>
<th>Configuration</th>
<th>Schematic</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>ON</td>
<td></td>
</tr>
</tbody>
</table>

Table 12: SW2, Configuration for Normal Operation Mode

<11> Restarting the RFP  When the RFP is restarted, the latest settings should be applied.
Chapter 8  Applilet EZ for HCD Controller

Applilet EZ for HCD Controller is a software tool used to automatically generate software code for the RL78/I1A microcontroller (and also for the 78K0/Ix2), which is used to control the LED current.

Software can be easily generated by specifying the setting and operation of the RL78/I1A on the GUI. The generated software can be directly written into the flash memory of the RL78/I1A microcontroller via a USB cable and the operation can be performed and checked by using the RL78/I1A DC/DC LED Control Evaluation Board.

By using Applilet EZ for HCD Controller, a digital RL78/I1A-based lighting system can be designed without requiring a detailed knowledge of complex programming languages. Furthermore, microcontroller software development, which can usually take a certain amount of time, and operation evaluation can be significantly reduced.

For further information please refer to the “Applilet EZ for HCD Controller User’s Manual” which can be found on the Renesas website.

8.1 General Settings

This section will go through the different Applilet EZ for HCD Controller’s general settings.

<1> Open Applilet EZ for HCD Controller.
Under the **Project** menu all of the MCU settings will be listed for configuration, select **CPU** or simply press the “**New**” button.

![Figure 29: Applilet EZ for HCD Controller New Project](image)

In the CPU settings, select Target to **EZ-0012** board.

![Figure 30: Applilet EZ for HCD Controller CPU Settings](image)

The Applilet EZ tool is able to generate code and projects for different compilers, one of them is the new **CubeSuite+** compiler. Select it by clicking on the **Setting** menu, then **Select Compiler** and choose the **CubeSuite+** compiler.

![Figure 31: Applilet EZ for HCD Controller Compiler Selection](image)
Note Make sure that you have installed the selected compiler correctly to your host PC before building the project.

<5> It is also possible to configure the output project folders by clicking on the Setting menu and then selecting Project Folder.

These locations will specify the output paths of the generated files. Enter in your desired destination but please keep in mind that Applilet EZ will then create subdirectories under this folder for each Applilet EZ project. Click OK.

![Project Folder](image)

Figure 32: Applilet EZ for HCD Controller Project Folder

### 8.2 Fix Dimmer Program

This program sets a fixed duty value for each of the 3 LED channels. Make sure that all settings explained previously are still correctly set before proceeding with the following steps.

<1> Make sure “Fix Duty” is still selected as the dimmer program.

<2> Input “128” to all the channels so they are not too bright.

![Dimmer Program](image)

Figure 33: Applilet EZ for HCD Controller Fix Duty Settings

<3> We can then save the new Applilet EZ project (.hcd file). Select the File menu, then click on Save As… or simply click on the “Save” button, and input “fix.hcd” for example. To finish click Save.
Please make sure to set the SW2 dip switch to the flash programming mode. Then plug the power cable to the RL78/I1A DC/DC LED Control Evaluation Board, and plug the USB connector. Click the "All P." button.

You will be informed about the progress of the compilation.
<6> Next click **OK** when prompt to start flash programming.

![AppEzHCD](image)

**Figure 37:** Applilet EZ for HCD Controller Start Flash Programming

<7> During the flash programming procedure you will be informed about the actual status of the programming.

![Build](image)

**Figure 38:** Applilet EZ for HCD Controller Flash Programming Status

<8> Click **CLOSE** to exit the “Build” window. Remove the USB cable and the power supply cable, and change the SW2 dip switch positions to the normal operation mode. Plug the power supply cable to the board connector again and you should see the LEDs light up according to the duty values set earlier.

LED channel 1 = Red
LED channel 2 = Green
LED channel 3 = Blue
8.3 Variable Dimmer Program

This program sets the duty value for each channel according to a drawing pattern data.

<1> Make sure that you have set all the settings as explained in the 8.1 General Settings section.

<2> Save the new Applilet EZ project (.hcd file). Select the File menu, then click on Save As… or simply click on the “Save” button, and input “variable.hcd” for example. To finish click Save.

![Figure 39: Applilet EZ for HCD Controller Save As Window](image)

<3> We now have a new Applilet EZ project file and we will change the dimmer program to Variable.

![Figure 40: Applilet EZ for HCD Controller Dimmer Program Selection (Variable)](image)

<4> Click on the “Edit” button under “Variable” and the “Dimmer Programming” window will open. Enable the “Cyclic” check box. Click the “Ch.1” button to select this channel for modification. Select the line mode as shown below. This will allow you to draw the PWM duty cycle versus time by using your mouse pointer.
Figure 41:  Applilet EZ for HCD Controller Dimmer Programming (Variable)

<5>  Draw something close to the sinusoidal wave below and then click OK.

Figure 42:  Applilet EZ for HCD Controller Wave Editor (1 channel)
Repeat the same process for the two other channels. Then click on the OK button to exit the variable dimmer control window.

Figure 43: Applilet EZ for HCD Controller Wave Editor (3 channels)

<7> Make sure that SW2 dip switch of the RL78/I1A DC/DC LED Control Evaluation Board is in flash programming mode, and that the USB and power supply cables are connected correctly. Click the “Save” button and then the “All P.” button. After downloading the application, please disconnect the USB and power supply cables and set the board to the normal operation mode.

<8> Plug again the DC 5V power supply, and you should now see the on-board LEDs running the variable dimming application based on the above wave form.

8.4 Analog Input Dimmer Program

This program sets the duty value for each channel according to the on-board variable resistors values read from the A/D converter.

<1> Make sure that you have set all the settings as explained in the 8.1 General Settings section.
Save the new Applilet EZ project (.hcd file). Select the File menu, then click on Save As… or simply click on the “Save” button, and input “analog.hcd” for example. To finish click Save.

We now have a new Applilet EZ project file and we will change the dimmer program to Analog Input.

Make sure that SW2 dip switch of the RL78/I1A DC/DC LED Control Evaluation Board is in flash programming mode, and that the USB and power supply cables are connected correctly. Click the “Save” button and then the “All P.” button. After downloading the application, please disconnect the USB and power supply cables and set the board to the normal operation mode.

Plug again the DC 5V power supply, and you should now see the on-board LED brightness changing according to the actions applied to the variable resistors (VR1, VR2 and VR3).

8.5 DMX512 Dimmer Program

This sample shows how to set up Applilet EZ to program the DM512 stack into the R5F107DEG assembled to the RL78/I1A DC/DC LED Control Evaluation Board.

Make sure that you have set all the settings as explained in the 8.1 General Settings section.

Save the new Applilet EZ project (.hcd file). Select the File menu, then click on Save As… or simply click on the “Save” button, and input “dmx512.hcd” for example. To finish click Save.

We now have a new Applilet EZ project file and we will change the dimmer program to DMX512.
Open the “DMX512 Property” dialogue box by selecting the Project menu and clicking on DMX512… or simply by clicking on the “Setting” button. Check that the settings are as shown below.

![DMX512 Property Dialogue Box](image)

Figure 46: Applilet EZ for HCD Controller DMX512 Property Dialogue Box

Make sure that SW2 dip switch of the RL78/I1A DC/DC LED Control Evaluation Board is in flash programming mode, and that the USB and power supply cables are connected correctly. Click the “Save” button and then the “All P.” button.

After downloading the application, please disconnect the USB and power supply cables and set the board to the normal operation mode.

You should now be able to control the LEDs on the RL78/I1A DC/DC LED Control Evaluation Board via the DMX512 protocol by connecting a DMX512 master device. For example, Renesas Electronics offers the Lighting Communication Master Evaluation Board (EZ-0008). This board can be used as a communication master device supporting DMX512, DALI and IR communications.

The RL78/I1A DC/DC LED Control Evaluation Board can be controlled by this Lighting Communication Master Evaluation Board together with a GUI running on the host PC. There is a GUI for DMX512 control and a GUI for DALI control, both GUIs can be downloaded from the Renesas Electronics website.

![System Configuration for DMX512 Control](image)

Figure 47: System Configuration for DMX512 Control
On the *Lighting Communication Master Evaluation Board*, please confirm that SW4 is set to “RUN” and SW3 is set to “DMX”.

Connect the *Lighting Communication Master Evaluation Board* (EZ-0008), via the DMX connector J1, with the *RL78/I1A DC/DC LED Control Evaluation Board* (acting as a DMX512 slave board), via the DMX connector CN3, using the three wires provided.

Connect the *Lighting Communication Master Evaluation Board* to the host PC using a USB cable.

Plug the DC 5V power supply cable to the *RL78/I1A DC/DC LED Control Evaluation Board* via connector CN1.

Send DMX512 commands to the *RL78/I1A DC/DC LED Control Evaluation Board* using the DMX512 Master Controller GUI.

**Note** To find details about the DMX512 Master Controller GUI, please refer to the corresponding User’s Manual (U19596EJ1V0UM00) that can be downloaded from the Renesas Electronics website.

### 8.6 DALI Dimmer Program

This sample shows how to set up Applilet EZ to program the DALI (Digital Addressable Lighting Interface) stack into the R5F107DEG assembled to the *RL78/I1A DC/DC LED Control Evaluation Board*.

Make sure that you have set all the settings as explained in the 8.1 General Settings section.

Save the new Applilet EZ project (.hcd file). Select the File menu, then click on Save As... or simply click on the “Save” button, and input “dali.hcd” for example. To finish click Save.

**Figure 48:** Applilet EZ for HCD Controller Dimmer Program Selection (DALI)
Open the “DALI Property” dialogue box by selecting the **Project** menu and clicking on **DALI…** or simply by clicking on the **Setting** button. Choose the appropriate settings for your evaluation.

![DALI Property Dialogue Box](image)

**Figure 49:** Applilet EZ for HCD Controller DALI Property Dialogue Box

Make sure that SW2 dip switch of the **RL78/I1A DC/DC LED Control Evaluation Board** is in flash programming mode, and that the USB and power supply cables are connected correctly. Click the “**Save**” button and then the “**All P.**” button. After downloading the application, please disconnect the USB and power supply cables and set the board to the normal operation mode.

You should now be able to control the LEDs on the **RL78/I1A DC/DC LED Control Evaluation Board** via the DALI protocol by connecting a DALI master device. For example, Renesas Electronics offers the **Lighting Communication Master Evaluation Board** (EZ-0008). This board can be used as a communication master device supporting DMX512, DALI and IR communications.

The **RL78/I1A DC/DC LED Control Evaluation Board** can be controlled by this **Lighting Communication Master Evaluation Board** together with a GUI running on the host PC. There is a GUI for DMX512 control and a GUI for DALI control, both GUIs can be downloaded from the Renesas Electronics website.

![System Configuration for DALI Control](image)

**Figure 50:** System Configuration for DALI Control
On the Lighting Communication Master Evaluation Board, please confirm that SW4 is set to "RUN".

Connect the Lighting Communication Master Evaluation Board (EZ-0008), via the DALI connector J4, with the RL78/I1A DC/DC LED Control Evaluation Board (acting as a DALI slave board), via the DALI connector CN2, using the two wires provided.

Connect the Lighting Communication Master Evaluation Board to the host PC using a USB cable.

Plug the DC 5V power supply cable to the RL78/I1A DC/DC LED Control Evaluation Board via connector CN1.

Send DALI commands to the RL78/I1A DC/DC LED Control Evaluation Board using the DALI Master Controller GUI.

To find details about the DALI Master Controller GUI, please refer to the corresponding User’s Manual (U19607EJ1V1UM00) that can be downloaded from the Renesas Electronics website.

8.7 IR Remote Control Dimmer Program

This sample shows how to set up Applilet EZ to program the IR remote control dimming program into the R5F107DEG assembled to the RL78/I1A DC/DC LED Control Evaluation Board.

The data code switching function by SW3 is supported for Applilet EZ for HCD Ver. 7.00 or later. To switch a data code in an Applilet EZ for HCD version earlier than Ver. 7.00, rewrite the data code.

Make sure that you have set all the settings as explained in the 8.1 General Settings section.

Save the new Applilet EZ project (.hcd file). Select the File menu, then click on Save As… or simply click on the “Save” button, and input “ir.hcd” for example. To finish click Save.

We now have a new Applilet EZ project file and we will change the dimmer program to IR Remote Control. The “Custom Code” and “Data Code” can be customized.

Enter the data code using two digits in hexadecimal. To use the data code "0x5AA5" for dimming, for example, enter "0x5A". During actual processing, the data code and its inverted code (0xA5 in this example) are used for reception confirmation.

Note

Note
Applilet EZ for HCD Controller Dimmer Program Selection (IR)

Make sure that SW2 dip switch of the RL78/I1A DC/DC LED Control Evaluation Board is in flash programming mode, and that the USB and power supply cables are connected correctly. Click the “Save” button and then the “All P.” button. After downloading the application, please disconnect the USB and power supply cables and set the board to the normal operation mode.

Plug again the DC 5V power supply, and you should now be able to control the LEDs on the RL78/I1A DC/DC LED Control Evaluation Board via the IR remote control protocol by using an IR transmitter device. For example, Renesas Electronics offers the Lighting Communication Master Evaluation Board (EZ-0008). This board can be used as a communication master device supporting DMX512, DALI and IR communications.

On the Lighting Communication Master Evaluation Board, please confirm that SW4 is set to “RUN” and SW1 to the expected channel (the channel should be the same as the one set in Applilet EZ for HCD).

The output code is based on NEC IR remote control protocol:
CH1: Send custom code 0x0000+data code 0x5AA5
CH2: Send custom code 0x0000+data code 0xDA25

Place the IR transmitter (LED1) of the Lighting Communication Master Evaluation Board in the line-of-sight of the IR receiver (U2) of the RL78/I1A DC/DC LED Control Evaluation Board.

Connect the Lighting Communication Master Evaluation Board to the host PC using a USB cable.
<9> Plug the DC 5V power supply cable to the *RL78/I1A DC/DC LED Control Evaluation Board* via connector CN1.

<10> Press switch SW2 of the *Lighting Communication Master Evaluation Board* to send IR signals to the *RL78/I1A DC/DC LED Control Evaluation Board*. 
Chapter 9 Troubleshooting

- **In driver installation, recognition based on Plug and Play is disabled.**

  **Cause:**
  The USB connector may not be inserted normally into the USB port of the personal computer.

  **Action:**
  Check that the USB connector is inserted fully into the USB port of the personal computer.
  Alternatively, disconnect the USB connector, and then insert the USB connector again after a while.

- **The driver file cannot be found at a specific location**

  **Cause:**
  The driver may not be installed correctly.

  **Action:**
  Install the USB driver again by referring to Chapter 6 Software Installation.

- **In checking by Device Manager, "USB Serial Port" or "USB High Speed Serial Converter" is not displayed. Alternatively, the "!" or "x" is prefixed**

  **Cause:**
  The USB connector may not be inserted normally into the USB port of the personal computer.

  **Action:**
  Check that the USB connector is inserted fully into the USB port of the personal computer.
  Alternatively, disconnect the USB connector from the USB port, then insert the USB connector again after a while.

  **Cause:**
  The driver may not be installed correctly.

  **Action:**
  <1> When this product is connected to the personal computer, right-click the driver marked with "!" or "x".
  Click **Erase** when displayed.
  <2> On Device Manager, execute [Hardware Modification Scan].
  <3> Install the driver again with Plug and Play.

  **Cause:**
  The device may not be recognized (in the case of connection with the USB hub).
Action:
Try the following:
• Disconnect the USB connector, then insert the USB connector again.
• Connect the USB connector to another port of the USB hub.
If the same symptom occurs, do not use the USB hub, but directly connect the connector to the USB port of the personal computer.

• When this product is connected with a personal computer, the "Add New Hardware Wizard" screen is displayed

Cause:
If the USB connector of this product is not inserted into the USB port used at the installation time but into another USB port, this product may be recognized as a new hardware item.
Action:
Install the driver by referring to Chapter 6 Software Installation.

• Communication with the RL78/I1A DC/DC LED Control Evaluation Board is disabled

Cause:
The driver may not be installed correctly.
Action:
Check if the USB driver is installed correctly by referring to Chapter 6 Software Installation.

Cause:
The COM port selected via the “Port list box” within device setup menu of RFP may not be set correctly.
Action:
Set the port checked using Device Manager.

Cause:
The RL78/I1A DC/DC LED Control Evaluation Board is operating in Virtual UART mode.
Action:
Set the board to the On-Board Debugging / Flash Programming mode.

Cause:
The PRM file selected in [Device Setup] may be incorrect.
Action:
Use the corresponding PRM file that matches the target device. For information about the PRM file, refer to Chapter 7 How to Use Renesas Flash Programmer (RFP).
Chapter 10 Schematics

Figure 53: RL78/I1A DC/DC LED Control Evaluation Board Schematic
Figure 54: Top and Bottom Silkscreen
## Chapter 11 Bill of Materials

<table>
<thead>
<tr>
<th>Item</th>
<th>Reference</th>
<th>Parts name</th>
<th>Manufacturer</th>
<th>Type</th>
<th>Part Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>C1, C2</td>
<td>Laminated ceramic capacitor</td>
<td>Murata Manufacturing</td>
<td>1005</td>
<td>GRM153SC1H3R7CDD5#</td>
</tr>
<tr>
<td>2</td>
<td>C3</td>
<td>Laminated ceramic capacitor</td>
<td></td>
<td>1608</td>
<td>GRM188B31E474KA75D</td>
</tr>
<tr>
<td>3</td>
<td>C4, C5</td>
<td>Laminated ceramic capacitor</td>
<td></td>
<td>1608</td>
<td>GRM188B31H104KA92</td>
</tr>
<tr>
<td>4</td>
<td>C101-C103, C201-C203, C301-C303</td>
<td>Laminated ceramic capacitor</td>
<td></td>
<td>2012</td>
<td>GRM21BB31C106KE15L</td>
</tr>
<tr>
<td>5</td>
<td>C104, C105, C204, C205, C304, C305, C401, C403, C404, C501, C503, C509-C511</td>
<td>Laminated ceramic capacitor</td>
<td></td>
<td>1608</td>
<td>GRM188B31H104KA92</td>
</tr>
<tr>
<td>6</td>
<td>C402, C502, C512</td>
<td>Electrolytic capacitor</td>
<td>Panasonic</td>
<td>DIP</td>
<td>EEEUFM1H220</td>
</tr>
<tr>
<td>7</td>
<td>C504</td>
<td>Laminated ceramic capacitor</td>
<td>Murata Manufacturing</td>
<td>1608</td>
<td>GRM188B11H103KA01D</td>
</tr>
<tr>
<td>8</td>
<td>C505, C506</td>
<td>Laminated ceramic capacitor</td>
<td></td>
<td>1608</td>
<td>GRM1882C1H390JA01</td>
</tr>
<tr>
<td>9</td>
<td>C507, C508</td>
<td>Laminated ceramic capacitor</td>
<td></td>
<td>1608</td>
<td>GRM188B31E474KA75D</td>
</tr>
<tr>
<td>10</td>
<td>CN1</td>
<td>Power Supply Jacks</td>
<td>Marusin electric mfg</td>
<td>DIP</td>
<td>M04-730A0</td>
</tr>
<tr>
<td>11</td>
<td>CN2</td>
<td>Connector</td>
<td>SATO PARTS</td>
<td>DIP</td>
<td>ML-800S1V-2P</td>
</tr>
<tr>
<td>12</td>
<td>CN3</td>
<td>Connector</td>
<td>SATO PARTS</td>
<td>DIP</td>
<td>ML-800S1V-3P</td>
</tr>
<tr>
<td>13</td>
<td>CN501</td>
<td>USB connector</td>
<td>HIROSE ELECTRIC</td>
<td>SMD</td>
<td>UX60A-MB-5ST</td>
</tr>
<tr>
<td>14</td>
<td>D101-D103, D201-D203, D301-D303</td>
<td>Schottky-barrier diode</td>
<td>Renesas Electronics</td>
<td>SMD</td>
<td>HRV103B</td>
</tr>
<tr>
<td>15</td>
<td>D401, D402, D501-D503</td>
<td>Diode</td>
<td>Rohm</td>
<td>DIP</td>
<td>1SS133</td>
</tr>
<tr>
<td>16</td>
<td>DB1</td>
<td>Bridge diode</td>
<td>Shindengen Electric Manufacturing</td>
<td>SMD</td>
<td>S1ZB60-7102</td>
</tr>
<tr>
<td>17</td>
<td>J1, J2</td>
<td>DIP pin header</td>
<td>HIROSE ELECTRIC</td>
<td>DIP</td>
<td>HIF3H-20PB-2.54DSA</td>
</tr>
<tr>
<td>19</td>
<td>J3</td>
<td>SIP pin header</td>
<td>KEL</td>
<td>DIP</td>
<td>DSP03-006-432G</td>
</tr>
<tr>
<td>20</td>
<td>L1-L3</td>
<td>Inductance</td>
<td>TDK</td>
<td>SMD</td>
<td>SLF7045T-151MR40-PF</td>
</tr>
<tr>
<td>21</td>
<td>LED101</td>
<td>High power LED</td>
<td>OSRAM AG</td>
<td>SMD</td>
<td>LRW55M-GZHZ-1</td>
</tr>
<tr>
<td>22</td>
<td>LED201</td>
<td>High power LED</td>
<td></td>
<td>SMD</td>
<td>LTW55M-HYZ36Z</td>
</tr>
<tr>
<td>23</td>
<td>LED301</td>
<td>High power LED</td>
<td></td>
<td>SMD</td>
<td>LBW55M-FYGX-24</td>
</tr>
<tr>
<td>24</td>
<td>PC401, PC402</td>
<td>Photocoupler</td>
<td>Renesas Electronics</td>
<td>SMD</td>
<td>PS2561AL-1-A</td>
</tr>
<tr>
<td>25</td>
<td>Q101, Q201, Q301, Q401</td>
<td>Transistor</td>
<td>Renesas Electronics</td>
<td>SC-59</td>
<td>2SC1623A-L6</td>
</tr>
<tr>
<td>26</td>
<td>Q102, Q202, Q302</td>
<td>Transistor array</td>
<td></td>
<td>SMD</td>
<td>uPA679TB</td>
</tr>
<tr>
<td>27</td>
<td>Q103, Q203, Q303</td>
<td>Power MOSFET</td>
<td></td>
<td>TO-252</td>
<td>2SJ325-Z-E1-AZ</td>
</tr>
<tr>
<td>28</td>
<td>R1, R101, R107, R201, R207, R301, R307, R406, R504, R506, R512</td>
<td>SMT resistor</td>
<td>KOA</td>
<td>2012</td>
<td>RK73B2ATTD103J</td>
</tr>
<tr>
<td>29</td>
<td>R2, R408, R511</td>
<td>SMT resistor</td>
<td></td>
<td>2012</td>
<td>RK73B2ATTD102J</td>
</tr>
<tr>
<td>Item</td>
<td>Reference</td>
<td>Parts name</td>
<td>Manufacturer</td>
<td>Type</td>
<td>Part Number</td>
</tr>
<tr>
<td>------</td>
<td>-----------</td>
<td>------------</td>
<td>--------------</td>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td>30</td>
<td>R102, R104, R202, R204, R302, R304</td>
<td>SMT resistor</td>
<td>NIDEC COPAL ELECTRONICS</td>
<td>SMD</td>
<td>CAS-220-TB1</td>
</tr>
<tr>
<td>31</td>
<td>R103, R105, R203, R205, R303, R305</td>
<td>SMT resistor</td>
<td>OMRON</td>
<td>SMD</td>
<td>A6S-8104-H</td>
</tr>
<tr>
<td>32</td>
<td>R106, R206, R306</td>
<td>SMT resistor</td>
<td>ALPS ELECTRIC</td>
<td>DIP</td>
<td>SSABO10200</td>
</tr>
<tr>
<td>33</td>
<td>R108, R208, R308</td>
<td>SMT resistor</td>
<td>OMRON</td>
<td>SMD</td>
<td>B3S-1000</td>
</tr>
<tr>
<td>34</td>
<td>R109, R209, R309</td>
<td>SMT resistor</td>
<td>Renesas Electronics</td>
<td>SMD</td>
<td>R5F107DE</td>
</tr>
<tr>
<td>35</td>
<td>R401</td>
<td>SMT resistor</td>
<td>Sharp</td>
<td>DIP</td>
<td>GP1UX511GS</td>
</tr>
<tr>
<td>36</td>
<td>R110, R210, R310, R507-R510, R513, R515</td>
<td>SMT resistor</td>
<td>Renesas Electronics</td>
<td>SMD</td>
<td>uPD78F0730MC</td>
</tr>
<tr>
<td>37</td>
<td>R402</td>
<td>SMT resistor</td>
<td>Texas Instruments</td>
<td>SMD</td>
<td>SN75176BD</td>
</tr>
<tr>
<td>38</td>
<td>R501, R505</td>
<td>SMT resistor</td>
<td>Texas Instruments</td>
<td>SMD</td>
<td>SN74LVC1G125DCK</td>
</tr>
<tr>
<td>39</td>
<td>R502, R503</td>
<td>SMT resistor</td>
<td>Renesas Electronics</td>
<td>SMD</td>
<td>uPD78F0730MC</td>
</tr>
<tr>
<td>40</td>
<td>R404</td>
<td>SMT resistor</td>
<td>Texas Instruments</td>
<td>SMD</td>
<td>SN75176BD</td>
</tr>
<tr>
<td>41</td>
<td>R405</td>
<td>SMT resistor</td>
<td>Texas Instruments</td>
<td>SMD</td>
<td>SN74LVC1G125DCK</td>
</tr>
<tr>
<td>42</td>
<td>R407</td>
<td>SMT resistor</td>
<td>Texas Instruments</td>
<td>SMD</td>
<td>SN75176BD</td>
</tr>
<tr>
<td>43</td>
<td>R110, R210, R310, R507-R510, R513, R515</td>
<td>SMT resistor</td>
<td>Texas Instruments</td>
<td>SMD</td>
<td>SN75176BD</td>
</tr>
<tr>
<td>44</td>
<td>R514</td>
<td>SMT resistor</td>
<td>Texas Instruments</td>
<td>SMD</td>
<td>SN74LVC1G125DCK</td>
</tr>
</tbody>
</table>

Table 13: Bill of Materials
<table>
<thead>
<tr>
<th>Rev.</th>
<th>Date</th>
<th>Page</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.00</td>
<td>Mar. 23, 2012</td>
<td>—</td>
<td>First edition issued</td>
</tr>
<tr>
<td>2.00</td>
<td>Sep. 30, 2012</td>
<td>Throughout</td>
<td>Change of WriteEZ5 to Renesas Flash Programmer (RFP)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p. 1</td>
<td>Change of the description in Chapter 1 Introduction</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p. 1</td>
<td>Change of the description in 1.1 Main features of RL78/I1A DC/DC LED Control Evaluation Board</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p. 3</td>
<td>Change of the description in 2.1 RL78/I1A DC/DC LED Control Evaluation Board</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p. 3</td>
<td>Change of the description in 2.3 Power Supply</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p. 4</td>
<td>Addition of a schematic to Table 1 SW2, Normal Operation Mode</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p. 5</td>
<td>Change of the description in 3.1.2 On-Board Debug (OCD) Mode / Flash Programming Mode</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p. 5</td>
<td>Addition of a schematic to Table 2 SW2, On-Board Debug / Flash Programming Mode</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p. 5</td>
<td>Addition of a schematic to Table 3 SW2, E1 On-Chip Debug Mode</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p. 6</td>
<td>Addition of a schematic to Table 4 SW2, Virtual UART Mode</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p. 6</td>
<td>Addition of a schematic to Table 5 SW1, Lighting Communication Protocol Selection</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p. 7</td>
<td>Addition of a schematic to Table 6 SW3, IR Remote Control Channel Selection</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p. 7</td>
<td>Addition of Note to 3.3 Configuration Switch SW3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>pp. 24 to 28</td>
<td>Change of the description in Chapter 7 How to Use Renesas Flash Programmer (RFP)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p. 24</td>
<td>Addition of a schematic to Table 11 SW2, Configuration for Flash Programming Mode</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p. 28</td>
<td>Addition of a schematic to Table 12 SW2, Configuration for Normal Operation Mode</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p. 41</td>
<td>Addition of Note to 8.7 IR Remote Control Dimmer Program</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p. 44</td>
<td>Change of description in Cause and Action for the problem “The driver file cannot be found at a specific location” in Chapter 9 Troubleshooting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>p. 48</td>
<td>Addition of manufacturers and part numbers, and update of information of R310 and R513 in Chapter 11 Bill of Materials</td>
</tr>
</tbody>
</table>
RL78/I1A DC/DC LED Control Evaluation Board